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Overview
FontShow for Windows 95/NT is a small program useful for viewing the TrueType fonts installed on your system. Options are 
included to display user-specified sample text in place of the normal font name and alphanumeric character set. The size and 
face of the currently selected font can be quickly changed and the results displayed automatically.

The selected font's metrics can be viewed in a small font properties window by simply double-clicking on the font name in the 
pick list. MS Windows stock font objects can also be displayed with this utility, making it handy for programmers and developers.

Character Set Chart
FontShow also provides a small window that displays the entire character set for the currently selected font. ASCII codes can be
viewed and special characters can be copied to the MS Windows Clipboard.

Desktop Locations
FontShow’s location on the desktop is saved when the program is exited. Whenever you start FontShow it will reappear on the 
desktop where you last placed it. FontShow property sheet locations are also stored and reused the next time they are opened.

Taskbar Tray
FontShow for Windows 95/NT can be optionally configured to place its program icon in the Taskbar Icon Notification Tray. This 
option provides a simple means of keeping the taskbar button region clear for other running programs.



Installing FontShow
Installation
To install FontShow for Windows 95/NT on your computer simply create a new, empty folder and place the files; 
FONTSHOW.EXE, FONTSHOW.HLP and FONTSHOW.CNT there.

FONTSHOW.EXE - The FontShow Application
FONTSHOW.HLP - The Windows 95/NT Help File
FONTSHOW.CNT - The Help Contents File

To integrate FontShow for Windows 95/NT with the MS Windows Explorer select the FontShow Explorer Setup property sheet 
while FontShow is running.

Note If you have an earlier version of FontShow for Windows 95/NT installed on your computer, simply replace the 
FONTSHOW.EXE, FONTSHOW.HLP and FONTSHOW.CNT files with the newer versions.

Note The FONTSHOW.INI file is no longer used and can be deleted. The various application settings specified in the FontShow 
Options property sheet as well as the main window’s size and location on the desktop are now stored in the MS Windows 95/NT
System Registry.

Note Some earlier versions of FontShow for Windows 95/NT included a FONTSHOW.WRI documentation file. This file has been
replaced by the FONTSHOW.HLP file and can now be deleted.

Warning If you rename the FONTSHOW.EXE file you must also rename the HLP file using the same basename. For example if 
you change the FontShow application file name to NewName.exe, rename the help file to NewName.hlp. Do not rename the 
FONTSHOW.CNT file however. The HLP and CNT files must reside in the same folder as the FontShow application file itself.



Configuring FontShow
FontShow Options
Select the File | Options menu item to display the FontShow Options property sheet. This window will allow you to change the 
various FontShow program settings listed below.

Show Toolbar Tips
Check this item to display small popup tip windows when the mouse pointer is placed over toolbar ribbon pushbuttons. A short
description of the button currently beneath the mouse will be shown when this item is checked.

Dark Window Backgrounds
Check this item to display the text in list windows with a dark background instead of the paper white background MS Windows
normally uses when displaying text.

Launch Multiple Instances
Check this item to allow more than one instance of FontShow to be run on the desktop. This option is useful if you would like 
to compare font selections.

Place Icon in Taskbar Tray
Check this item to display a small FontShow program icon in the Taskbar Icon Notification Tray. If this item is selected and the 
FontShow window is minimized a button will not be added to the Taskbar, to restore the FontShow window on the desktop 
press the small icon in the taskbar tray instead. This option is available to keep the taskbar free for other running programs.

Note When this option is selected, clicking on the Close box in the upper right-hand corner of the window title bar will 
minimize FontShow instead of closing the application. To quit FontShow right-click with your mouse on the FontShow icon in 
the Taskbar tray. You may also use the File | Exit menu command or the Ctrl+Q keyboard shortcut.

Confirm Program Exit
Check this item to confirm quitting FontShow for Windows 95/NT. When this option is selected you will be prompted to confirm
your intention to exit FontShow and return to the MS Explorer desktop. This item is useful if you run FontShow from the tray 
and wish to avoid accidental exits when you right-click on the FontShow tray icon.

Sample Text for Testing Fonts
Use this entry field to define the text to be displayed when a font has been selected. The text you enter here will be displayed 
at the bottom of the FontShow window in the currently selected font face, style and size.

Sounds with Warning Dialog Boxes
Check this box to play a short beep sound when FontShow displays a warning dialog box or an error occurs.

OK
Press this button when you have completed your selection of FontShow program options. When you press this button the 
FontShow Options property sheet will be closed and your settings will be saved.

Cancel
Press this button to close the FontShow Options property sheet without making any changes. If you have made any changes 
to the option settings, and then press this button your changes will not be used, and your previous settings will remain in use.

Help
Press this button to open the FontShow Help window and go directly to the Configuring FontShow topic.

Note The options you have selected will be saved when you press the OK button. The desktop location of the FontShow 
Options window itself will also be stored. Your settings will be saved in the MS Windows 95/NT System Registry.



FontShow Explorer Setup
FontShow Explorer Setup
Select the Help | Setup menu item to display the FontShow Setup property sheet. This window will allow you to integrate 
FontShow for Windows 95/NT with the Microsoft Windows 95/NT Explorer. Use this command to create and remove MS 
Explorer shortcuts.

Create a Start Menu Item
Check this item to create a FontShow Start Menu entry. The FontShow for Windows 95/NT program will be located in the 
Software by Design folder on the Programs menu. This item will be disabled (grayed) if a FontShow item already exists in the 
Software by Design folder.

Remove this Start Menu Item
Check this item to remove the FontShow entry located in the Software by Design folder on the Programs menu. This item will 
be disabled (grayed) if a FontShow item does not already exist in the Software by Design folder.

Create a Desktop Icon
Check this item to create a FontShow for Windows 95/NT program icon on the Explorer desktop. This item will be disabled 
(grayed) if a FontShow desktop icon already exists.

Remove Icon from the Desktop
Check this item to remove the FontShow for Windows 95/NT program icon from the Explorer desktop. This item will be 
disabled (grayed) if a FontShow desktop icon does not already exist.

Create a Startup Folder Item
Check this item to automatically run FontShow for Windows 95/NT whenever Microsoft Windows is started. This option 
creates a FontShow program icon in the MS Windows Explorer Startup folder. This item will be disabled (grayed) if a 
FontShow startup item already exists in the Startup folder.

Remove the Startup Folder Item
Check this item to remove FontShow from the MS Windows Explorer Startup folder. This item will be disabled (grayed) if a 
FontShow startup item does not already exist in the Startup folder.

OK
Press this button when you have completed your selection of MS Explorer shortcuts. When you press this button the 
FontShow Setup property sheet will be closed and the MS Explorer shortcuts you have selected will be created or removed.

Cancel
Press this button to close the FontShow Explorer Setup property sheet without creating or removing any MS Explorer 
shortcuts.

Help
Press this button to open the FontShow Help window and go directly to the FontShow Explorer Setup topic.



File Menu
File Menu Commands
The File menu provides commands to work with FontShow. A short description of each item follows:

Options
Opens the FontShow Options property sheet and allows you to change FontShow program settings. Use this command to 
configure the FontShow program.

Exit
Closes the FontShow program and returns control to the Explorer desktop. The Ctrl+Q shortcut can be used for this 
command.

Tip Commonly used File commands can be invoked using shortcut keys or buttons on the toolbar ribbon.



Edit Menu
Edit Menu Commands
The Edit menu provides commands used to edit the contents of the FontShow display window. A short description of each item 
follows:

Paste
Pastes the contents of the Clipboard at the current selection point in the Text Sample window. The Ctrl+V shortcut can be 
used for this command.

Show Clipboard
Opens the Clipboard window and displays its current contents.

Tip Commonly used Edit commands can be invoked using shortcut keys or buttons on the toolbar ribbon.



View Menu
View Menu Commands
The View menu provides commands used to change FontShow display options. These items provide a means of changing the 
FontShow window appearance. A short description of each item follows:

Stock Fonts
Use this command to load a list of all standard MS Windows 95/NT System fonts. The Ctrl+S shortcut can be used for this 
command.

TrueType
Use this command to load a list of all standard MS Windows 95/NT TrueType fonts. The Ctrl+T shortcut can be used for 
this command.

Font Properties
Use this command to open a small font properties window. The properties for the currently selected font will be displayed in
this window. The Alt+Enter shortcut can be used for this command

Refresh
Use this command to refresh the font list. This commend is useful if you have installed or deleted fonts while FontShow is 
active. The F5 shortcut can be used for this command

Chart
Use this command to display a character chart window for the currently selected font.

Minimize
Minimizes the FontShow window to a button or icon on the taskbar. The Ctrl+Y shortcut can be used for this command.

Always on Top
Use this command to keep the FontShow window top most on the desktop. When this item is checked the FontShow 
window will float above all other non-topmost windows on the desktop. This item is useful if you normally run FontShow 
with a small window that would be easily obscured by other applications. The Ctrl+T shortcut can be used for this 
command.

Tip Commonly used View commands can be invoked using shortcut keys or buttons on the toolbar ribbon.



Tools Menu
Tools Menu Commands
The Tools menu provides commands used to open MS Windows Font Utilities and Folders. A short description of each item 
follows:

Control Panel
Opens the Microsoft Windows 95/NT Control Panel window. The Ctrl+P shortcut can be used for this command.

Explore Fonts
Opens the Microsoft Windows 95/NT Explorer and displays the Fonts folder. The Ctrl+F shortcut can be used for this 
command.

Tip Commonly used Tool commands can be invoked using shortcut keys or buttons on the toolbar ribbon.



Help Menu
Help Menu Commands
The Help menu provides commands used to get help with FontShow operations. A short description of each item follows:

Contents
Opens the FontShow Help window and displays the Table of Contents. The F1 shortcut can be used for this command.

Search
Opens FontShow Help and displays the Search window. You can use this window to search for specific FontShow help 
topics.

How to Use Help
Opens a Help window that explains how to use the MS Windows 95/NT Help program.

Register
Displays the FontShow Shareware Registration Wizard. This wizard allows you to register    FontShow for Windows 95/NT 
for authorized use.

Setup
Displays the FontShow Explorer Setup property sheet. This window provides options to integrate FontShow with the MS 
Windows Explorer. Use this window to create MS Explorer Start Menu items and desktop icons.

Web Site
Opens your web browser application and goes directly to the Software by Design web site on the Internet.

About FontShow
Displays the FontShow splash box. This window contains program information, the current version of FontShow you are 
running and a program copyright notice. Click the mouse anywhere in this window to close it

Tip Commonly used Help commands can be invoked using shortcut keys or buttons on the toolbar ribbon.



Toolbar Buttons
Tool Ribbon Buttons
Most commonly used FontShow menu commands can also be quickly invoked by pressing a button on the toolbar ribbon 
displayed at the top of the main window. These buttons work exactly the same way as the corresponding menu items that they 
duplicate. The Toolbar selection on the View menu must be selected to display the toolbar ribbon.

Stock - Display stock system fonts

TrueType - Display TrueType fonts

Properties - Show font properties

Refresh - Refresh the font list

Paste - Insert Clipboard contents in the font sample window

Clipboard - Open the MS Windows Clipboard

Chart - Open the ASCII Character Chart

Topmost - Make FontShow topmost

Options - Open the FontShow Options dialog

Help - Open this Help file

About - Show FontShow splash box

Tip If the Show ToolBar Tips option is selected a small popup tip window will appear when the mouse pointer is placed over a 
button. A short description of what each button does can be viewed using this method.



Shortcut Keys
Shortcuts
Shortcut keys allow you to quickly invoke FontShow menu commands without first displaying the menu and then selecting an 
item from it. The most commonly used FontShow commands can be invoked using the following shortcut keys.

File Menu
Ctrl+Q Exit FontShow, and return to the desktop

Edit Menu
Ctrl+V Paste to the current position

View Menu
Ctrl+S Load Stock fonts
Ctrl+T Load TrueType fonts
Alt+Enter Show properties for current font
F5 Refresh the Font list
Ctrl+Y Minimize FontShow to a button or icon

Tools Menu
Ctrl+P Open the MS Windows Control Panel
Ctrl+F Open the MS Explorer Font Folder

Help Menu
F1 Display this Help file



Comments and Upgrades
Comments and Suggestions
If you have comments, questions or find any bugs in FontShow for Windows 95/NT please feel free to contact me on 
CompuServe.

Gregory Braun
CompuServe: 71613,2175
Email: 71613.2175@compuserve.com
Web Site: http://www.execpc.com/~sbd
Phone: 1.414.444.8497

Web Site
Visit my web site on the Internet to download the latest versions of all of my software offerings.

Software by Design Web Site

(http://www.execpc.com/~sbd)



Release History
FontShow for Windows 95/NT Release History

v2.0 Original in-house development and testing of MS Windows 95/NT conversion using the Microsoft Win32 SDK.

v2.1 Added 95/NT splash box for release.

v2.2 Added options to place program icon in the taskbar notification tray, and to save the desktop locations for all dialog 
boxes. 

v2.3 Added support for screen color settings as specified in the Display Properties dialog. Added default user and company 
name to the splash box.

v2.4 Moved all FontShow options and settings to the MS Windows 95/NT System Registry. Added an MS Windows 95/NT 
Help file. Added an ASCII Character Chart window. Added an automatic Explorer Setup facility. Added the Topmost 
button to the toolbar ribbon.

v2.5 Converted the FontShow Options dialog box to a three-tab property sheet. Fixed a bug that prevented proper window 
repositioning when the MS Explorer Taskbar was placed along the left edge or at the top of the desktop and the Auto 
Hide option is active.

v2.6 Fixed several minor bugs.

v2.7 FontShow now behaves like a true Taskbar Tray application. Fixed several minor bugs.

Last Update  March 11th, 1998

Web Site
Visit my web site on the Internet to download the latest versions of all of my software offerings.

Software by Design Web Site

(http://www.execpc.com/~sbd)



System Registry
FontShow for Windows 95/NT System Registry Key
FontShow for Windows 95/NT stores configuration settings in the MS Windows 95/NT System Registry. These settings are 
updated automatically while FontShow is running. There is no need to edit these settings manually.

If you insist upon editing these settings, you do so at your own risk. FontShow automatically updates registry entries when it 
exits. If you edit these settings make sure FontShow is not running while you edit them. If FontShow is currently running your 
changes will be overwritten when FontShow exits.

FontShow for Windows 95/NT stores configuration settings in the following system registry key:

HKEY_CURRENT_USER
Software

Software by Design
FontShow for Windows 95/NT

Section
Label = Value

Warning There is no need to edit these settings manually. FontShow will automatically maintain these settings for you. If you do 
edit these, you do so at your own risk.



Removing FontShow
Removing FontShow for Windows 95/NT
If you find that FontShow for Windows 95/NT does not meet your needs you can remove it from your computer system by simply
deleting the following files from your hard drive. All of these files will be located in the folder that you originally installed 
FontShow in.

FontShow.exe FontShow for Windows 95/NT application program.
FontShow.cnt FontShow Help Topics File
FontShow.hlp FontShow Help File

If you have opened and used the FontShow for Windows 95/NT Help files your system may contain the following two (2) files. 
These files are created by the standard MS Windows 95/NT Help program WinHlp32.exe. These files may also be safely 
removed.

FontShow.gid MS Windows Help settings file. This file contains the FontShow Help window size and desktop location 
as well as any bookmarks you may have created.

FontShow.fts MS Windows Help word database. This file is created when you build a custom word list for FontShow 
Help files. This file is used to search for words and phrases in the FontShow Help files.

FontShow for Windows 95/NT does not use any custom DLL files or system drivers. If you delete the files mentioned above from
your system’s hard drive you will have completely removed FontShow from your computer system.

Note If you have installed FontShow shortcuts on the MS Explorer Start Menu use the Help | Setup command to remove the 
shortcuts you created before you delete the FontShow files mentioned above.



Software by Design Web Site
Software by Design
You can download the latest versions of all of my software from my web site on the Internet. I post the latest releases of my 
software there first. Click your mouse on the link listed below to visit the Software by Design web site.

Software by Design Web Site

(http://www.execpc.com/~sbd)

Software Titles
The following software titles are available at my web site on the Internet and can also be found on CompuServe, ExecPC, MSN 
and ZD Net.

NoteBook for Windows (NBOOK.ZIP)
NoteBook for Windows 95/NT (NBOOK32.ZIP)
Reminders for Windows (REMIND.ZIP)
Reminders for Windows 95/NT (REMIND32.ZIP)
ToolBar for Windows (TBAR.ZIP)
ToolBar for Windows 95/NT (TBAR32.ZIP)
Screen Loupe for Windows (LOUPE.ZIP)
Screen Loupe for Windows 95/NT (LOUPE32.ZIP)
Screen Loupe for Macintosh (LOUPE.SEA)
Audition for Windows 95/NT (AUDITION.ZIP)
Password Keeper for Windows 95/NT (PASSKEEP.ZIP)
CardBase for Windows 95/NT (CARDBASE.ZIP)
File Editor for Windows (FXEDIT.ZIP)
File Editor for Windows 95/NT (FXEDIT32.ZIP)
Crypto for Windows 95/NT (CRYPTO.ZIP)
Icon Extractor for Windows (ICONX.ZIP)
Icon Extractor for Windows 95/NT (ICONX32.ZIP)
FontShow for Windows 95/NT (FONTSHOW.ZIP)
TxEdit for Windows 95/NT (TXEDIT.ZIP)
DLL Show for Windows 95 (DLLSHOW.ZIP)
RGB Editor for Windows (RGB.ZIP)
RGB Editor for Windows 95/NT (RGB32.ZIP)
Quiz Wizard for Windows 95/NT (QUIZWIZ.ZIP)
Programmer's IDE (PMAN.ZIP)
Programmer's IDE 95/NT (PMAN32.ZIP)
Touch for Windows (WTOUCH.ZIP)
Disk CleanUp for Windows 95/NT (CLEANUP.ZIP)
BattleStar for Windows (BSTAR.ZIP)
BattleStar for Windows 95/NT (BSTAR32.ZIP)
World Radio for Macintosh (WRADIO.SEA)

Note The latest versions of my software programs are always posted on my web site first. Versions found on the other online 
services may be earlier releases.



BBS and Internet Operators
Webmasters
Please upload the original ZIP file intact and title the submission:

"FontShow for Windows 95/NT v2.7"
--Author Gregory Braun

Web Site
Visit my web site on the Internet to download the latest versions of all of my software offerings.

Software by Design Web Site

(http://www.execpc.com/~sbd)

Note This site also supports anonymous FTP transfers.



What is Shareware
The concept of "Shareware"...
Shareware, also known as user supported software and other names, is a concept not understood by everyone. The author of 
Shareware retains all rights to the software under the copyright laws while still allowing free distribution. This gives the user the 
chance to freely obtain and try out software to see if it fits their needs. Shareware should not be confused with Public Domain 
software even though they are often obtained from the same sources.

If you continue to use Shareware after trying it out, you are expected to register your use with the author and pay a registration 
fee. What you get in return depends on the author, but may include a printed manual, free updates, telephone support, etc. Only 
by paying for the Shareware you use do you enable the Shareware author to continue to support his software and create new 
programs. Considering that the Shareware registration fees are almost always far less than the purchase price of comparable 
commercial software it's obvious that Shareware is a good deal for everyone.

There are real advantages to you in the Shareware system. You get to try out software to make sure it is compatible with your 
hardware and that it fits your needs before you "buy" it with your registration. The author saves the expense of advertising, 
packaging and distribution and passes the savings on to you. Plus, most Shareware authors are much more accessible than 
commercial software sources so that your questions and suggestions are much more likely to be responded to.

Thank you for your support.



Registering FontShow for Windows 95/NT
Registering FontShow
FontShow for Windows 95/NT is distributed as shareware. You may evaluate it free of charge for 30 days. After 30 days if you 
continue to use FontShow for Windows 95/NT you are required to register it. If after evaluating FontShow for 30 days you decide
not to register it you are required to remove it from your computer.

Registration entitles you to unlimited free updates and telephone support.

You can register FontShow for Windows 95/NT by mailing the Order Form provided with this software. When you register 
FontShow for Windows 95/NT you will receive your registration code by E-Mail, or optionally you may request that your 
registration code be mailed to you.

The software you are currently using is a fully functioning program. There are no time limitations built into the software to restrict 
its continued use and no program features have been disabled. As a registered user you will however be able to disable the 
initial splash box that appears when FontShow for Windows 95/NT is first launched.

To register your copy of FontShow for Windows 95/NT select the Help | Register menu command. The Shareware Registration 
Wizard will be displayed when this menu command is selected. Use this window to fill in the following entry fields:

User Name
Enter the user name you originally specified when you ordered FontShow for Windows 95/NT.

Organization
Enter the name of your organization as originally specified when you ordered FontShow for Windows 95/NT. If you did not 
specify an organization name leave this field blank.

Registration
Enter the registration code that was provided to you. Enter your registration code exactly as provided. Do not include spaces 
when entering your registration code.

Note The registration code was provided to you when you purchased FontShow for Windows 95/NT. Refer to the notification 
letter that was mailed to you or the E-Mail message you received for your personal shareware registration code.

Show Splash Box at Startup
This box will be initially checked if you have not registered FontShow for Windows 95/NT. When you successfully register your
copy of FontShow this box will automatically be unchecked for you. If you wish to see the splash box when FontShow is 
launched return to this Registration Wizard and check this box.

OK
Press this button after you have filled out the Shareware Registration Wizard to complete FontShow for Windows 95/NT 
shareware registration.

Cancel
Press this button to close the Shareware Registration Wizard    without making any changes.

Help
Press this button to open the FontShow Help window and go directly to the Registering FontShow topic.



Purchasing Information
Purchasing Information
FontShow for Windows 95/NT is distributed as shareware. You may evaluate it free of charge for 30 days. After 30 days if you 
continue to use FontShow for Windows 95/NT you are required to register it. If after evaluating FontShow for 30 days you decide
not to purchase it you are required to remove it from your computer.

Registration entitles you to unlimited free updates and telephone support.

You can register FontShow for Windows 95/NT by mailing the Order Form provided with this software. When you register 
FontShow for Windows 95/NT you will receive your registration code by E-Mail, or optionally you may request that your 
registration code be mailed to you.

The software you are currently using is a fully functioning program. There are no time limitations built into the software to restrict 
its continued use and no program features have been disabled. As a registered user you will however be able to disable the 
initial splash box that appears when FontShow for Windows 95/NT is first launched.

Single User Licensing
Individual users can register FontShow for Windows 95/NT for $20.00 dollars. If you would also like a 3 ½” floppy disk sent to 
you please add an additional $5.00 dollars. Registration entitles you to unlimited free updates and telephone support. You can 
always download the latest release of FontShow directly from the Software by Design web site on the Internet. Print the 
FontShow for Windows 95/NT Order Form and mail it with your check to become a registered user of FontShow for Windows 
95/NT.

Site Licensing
FontShow for Windows 95/NT can also be registered for use at an entire site for $250.00 dollars. If you would like to install and 
use FontShow on multiple workstations at a single location choose this type of licensing. Registration includes a 3 ½” floppy disk
and entitles you to unlimited free updates and telephone support. You can always download the latest release of FontShow 
directly from the Software by Design web site on the Internet. Print the FontShow for Windows 95/NT Order Form and mail it 
with your check to become a registered user of FontShow for Windows 95/NT.

Corporate Licensing
FontShow for Windows 95/NT can also be registered for use at multiple sites for $1000.00 dollars. If you would like to install and
use FontShow on multiple workstations at multiple locations choose this type of licensing. Registration includes a 3 ½” floppy 
disk and entitles you to unlimited free updates and telephone support. You can always download the latest release of FontShow 
directly from the Software by Design web site on the Internet. Print the FontShow for Windows 95/NT Order Form and mail it 
with your check to become a registered user of FontShow for Windows 95/NT.



FontShow for Windows 95/NT Order Form
To print this order form, press the Print button above, or select Print Topic from the File pull-down menu.

To order by check, send this order form and a check to:

Gregory Braun
5609 West Hadley Street
Milwaukee, WI    53210-1554 U.S.A.

Payments must be in US dollars drawn on a US bank, or you can send international postal orders in US dollars.

All orders are subject to the License Agreement.

Customer information is considered confidential and will not be shared or distributed to any third parties.

Registered users of FontShow for Windows 95/NT are entitled to unlimited free program updates.

Single User Copy ______ at $20.00 each = ________

Optional 3 ½” Disk ______ at $5.00 each = ________
Site License ______ at $250.00 each = ________

Includes 3 ½” Disk
Corporate License ______ at $1000.00 each = ________

Includes 3 ½” Disk

Wisconsin Residents add 5.5% sales tax: ________

Total Payment: ________

Date ____________________________________

Name ____________________________________

Organization ____________________________________

Shipping Address ____________________________________

____________________________________

City ____________________________________

State ____________________________________

Zip Code ____________________________________

Country ____________________________________

Day Phone ____________________________________

E-Mail Address ____________________________________
[    ] Please send registration code via E-Mail

Comments:



License Agreement
License Agreement

You should carefully read the following terms and conditions before using this software.    Unless you have a different license 
agreement signed by Gregory Braun, your use of this software indicates your acceptance of this license agreement and 
warranty.

Registered Version
One registered copy of FontShow for Windows 95/NT may either be used by a single person who uses the software 
personally on one or more computers, or installed on a single workstation used nonsimultaneously by multiple people, but not 
both.

Site License
Any number of users at a single location may access the registered version of FontShow for Windows 95/NT through a 
network, provided that you have obtained a site license for the software covering all workstations that will access the software 
through the network. Any number of users at a single location can install and use the software on one or more computers or 
workstations.

Corporate License
Any number of users at any number of locations may access the registered version of FontShow for Windows 95/NT through 
a network, provided that you have obtained a corporate license for the software covering all workstations that will access the 
software through the network. Any number of users at any number of locations can install and use the software on one or 
more computers or workstations.

Software Updates
Registered users of FontShow for Windows 95/NT are entitled to unlimited free program updates. Software updates can be 
downloaded directly from the Software by Design web site on the Internet.

Governing Law
This agreement shall be governed by the laws of the State of Wisconsin.

Disclaimer of Warranty
THIS SOFTWARE AND THE ACCOMPANYING FILES ARE SOLD "AS IS" AND WITHOUT WARRANTIES AS TO 
PERFORMANCE OR MERCHANTABILITY OR ANY OTHER WARRANTIES WHETHER EXPRESSED OR IMPLIED. NO 
WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE IS OFFERED.

Good data processing procedure dictates that any program be thoroughly tested with non-critical data before relying on it. The
user must assume the entire risk of using the program.    ANY LIABILITY OF THE SELLER WILL BE LIMITED EXCLUSIVELY 
TO PRODUCT REPLACEMENT OR REFUND OF PURCHASE PRICE.




